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TERMINALFOUR Introduction to TERMINALFOUR Site Manager

Site Manager |7.4

“ Objective

> At a basic level, TERMINALFOUR Site Manager is used for building and maintaining large
amounts of content.

> Users at various levels can be given permission to add and modify content. All content goes
through an approval cycle, at which point dedicated "approvers" review the content. In some
cases this may be the authors who wrote the content; in other cases a more complex workflow
may be used to allow several people to review the content.

> Once content has been approved, it is ready to "go live". This happens in the publishing
process. Page Layouts (header/footer) and content layouts are wrapped around the content to
ensure the content is displayed correctly.

> One piece of content may be published to various channels. These are simply output
mechanisms, like websites, mobile sites, paper publishing, etc. By applying the Page Layouts
and Content Types, different displays can be achieved whilst still just producing one piece of
content.

> At the publishing stage, external data can also be incorporated. This could be information from
a database, website or similar.

Add & Modify
Content ® ®
Approval Cycle Management

Auditing and
Management Reports

Content Types and
Page Layouts
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Intranet
Internet
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iPhone / Mobile / PDA -
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Staff Intranets & Paper Publishing
Customer Portals
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® Objective
> Loginto TERMINALFOUR Site Manager.
> Open your user profile.

Username bburns
= 5 Groups Sample Data
UF| Authentication

Password [unchanged if left
blank]

Confirm Password

GatorLink Username

Default Language English |Z|

TERMINALFOUR Site Manager English - Generic (en) E
Password User Interface Language

Email Address * bburns@terminalfour.com

Html Editor Standard Textarea [=]

a

I agree to the terms of use for
the TERMINALFOUR Extranet.

. Make a note of your URL:

“ How To \

1. Open a web browser and navigate to your TERMINALFOUR Site Manager installation.
2. Enter your username and password; then click Login.
3. TERMINALFOUR Site Manager opens. Click on your username in the top right corner to open
your user profile:
a. You can change your Password.
b. If more than one Language is available, you can change language. This will change the
language of the site you work on when you log in.
c. You can select your preferred User Interface Language. This is used to set the interface
language of TERMINALFOUR Site Manager; menu items, site structure and user options.
d. You can update your Email Address; this is used for natifications sent from TERMINALFOUR
Site Manager.
e. If more than one HTML Editor is available, you can change editor. The default is TinyMCE.
f.  If more than one Preview Channel is available, you can set a default channel. This is used
when you preview your content to see how it will look on the live site.
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% Objective

> The first part of building a website is identifying at least the high level architecture. In
TERMINALFOUR Site Manager this involves building a Site Structure consisting of sections
(folders).

> There are a variety of different types of sections. These are displayed with different folder
symbols as displayed below.

> Once the different options have been explained by the trainer, build a small Site Structure you
can use as a base for your new website.

| 4 TERMINALFOUR Site Manager an A « English ¥ | * moderator | _ Logout
Content Rights & Roles Help
Show site structure
= Site Structure < & O Q [x] &) (B eew) (wn =+
Path : Home
Sample Data = . 1 1 0 0
- Last Modified m
= % Home x 2 2 0 0 Content
=T News = 2 1 ] 0
- = You have no recently
w’% Locations = N f L C modified content
@ B3 Events = - 0 0 0
= 1 Gallery = - 0 0 0
&' Resources = - 1 0 0 e
& & Blog ~ N z g © You have no items
=] E:la Intranet = 1 1 0 0 bookmarked -
= £3 Tools (= = 0 0 0

o Did you know?

Normal Section not hidden from navigation.

Hidden Section.

Root Section (level 1 of a Channel or Micro Site).

Mirrored Section (original location with write access).

Mirrored Section (“new” location with read access only).

Archive Section (content is not updated on publish).

Section with Access Control (only groups with access can view this section on the site).

LB el

. \

“ How To

1. If you are not already on the Site Structure screen, click the Site Structure B icon.

2. Atthe level instructed by the trainer, add a new section with your name. To do so, hover over the
Section Drop-Down Menu [z] and select Add Section.

3. Enter the relevant information to create a section. As a minimum, the Name must be filled in. All
other default options are explained on the next page.

4. Enter a name for the section and click Add.

5. Repeat the steps above to build a site structure with at least three main sections. A minimum of
one section should contain sub-sections as well.
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Add Section, Enter Details

Section: Home » Sample Data » Home » New Section

* 4 General Content Pagelayouts Metadata EditRights Access

General information about the section.

 naa JEETEES

Name

e
m
3

'R

Cutput URI
Access Key

SEOQ Key phrase(s)
Qutput File Name

Status Approved

Default Workflow —MNone —

Show in navigation?

eForm Section?

oo = B E

Archive Section

Content Owner Inherited [
Inherited Owner: No Owner set

No Owner set
‘wh Select Owner

Make this a link section? [

How To - continued

6. When creating sections, the only required element is Name. The elements are all described below:

a. Name: this is the name of your section and is typically also used directly in the menu
navigation.

b. Output URI: this is the Uniform Resource Identifier. If left blank, the section’s name is used
when publishing. It can be used to create a friendly URL or a shorter URL.

c. Access Key: lets you enter a single character, which may be used as a shortcut within a Link
Menu.

d. SEO Key Phrase(s): in order to run an SEO report for a channel, one of multiple SEO Key
Phrases must be set, at least at the root level.

e. Output File Name: enables you to specify a file name. If left blank, the default file name is
set by an Administrator.

f.  Status: select Approved, Pending or Inactive. Approved sections will publish if they contain
approved content. Pending sections will not publish. Inactive sections are marked for
deletion and can be permanently deleted by an Administrator.

g. Default Workflow: select the workflow you wish to use for all content added to this
section/branch.

h. Show in Navigation: if unchecked, the section will not appear in navigation and will be
displayed in the Site Structure with a grey folder icon.

i. eForm Section: this must be checked if eForms are going to submit content to this section.

j- Archive Section: if content is no longer updated, a section can be set as an archive. This will
save publish time, as the section will not be reviewed each time a publish is run.

k. Content Owner: select the user or group who “owns” the section. Content in the section will
inherit this ownership, unless a different owner is specified for the content.

I.  Make this a Link Section: check this to create a section linking directly to another section or
an external URL. This section cannot contain content.
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Move and Reorder Sections

TERMINALFOUR
Site Manager |7.4

% Objective

>  Sections can easily be moved, and the order in which they appear in navigation will change to

reflect this.

> Move one of your sections, using the drag and drop method.
> Reorder the sub-sections you created earlier. Use either automatic ordering or move them

manually.

o Did you know?

> Sections can also be dragged and dropped from the Direct Edit screen.

Modify Section, Show Details

Section: Home » Sample Data » Home » Locations

E site Structure

« W

w’gﬁ News
w’% Locations
Evenis
Gallery
Resources
Blog

Intranet

Tools

Style Assets
widgets
home page i
Widgets Hor
Register

Rating Resul
TERMINALFC

(% &
CelPrErPEDRD 0D

= % Self Service

= f3 Mobile Home

m

4 General Content

List of Subsections
Automatic Ordering

Enabled
Method

Existing Subsections

Hame
Ireland

United Kingdom
United States

Erance

Spain

Page Layouts Metadata Edit Rights | Subsections

Access

Alphabetical (A-Z)

Last Modified
03 Aug '12 08:09:41
03 Aug '12 08:09:41
03 Aug '12 08:09:41
03 Aug '12 08:09:41

03 Aug '12 08:09:41

]
(=]

Add Subsection

Save Changes

Move

EE
=] e
=] e
EE
E EE

Lock/UnLack All &

B BH B &

E

Lock

B & & & §

=

—

Save Changes

screen.

down.

“ How To

1. Tomove a section, drag it with your mouse and drop it to the new location.
2. Toreorder sections, click the Site Structuref icon if you are not already on the Site Structure

3. Select Modify Section from the Section Drop-Down Menu [=.

a. Select the Subsections tab.

b. If you wish to use Automatic Ordering, check the box Enabled and select a Method. By
default, all sections are locked. Unlock the sections you wish to apply Automatic Ordering
to. To do this, use the Lock/Unlock All button or check the individual items.

c. If you wish to manually move the sections, use the Move arrows to move sections up and

~

d. Click Save Changes before navigating away from this screen, as the changes will otherwise
not be saved.
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Site mﬁbi?ﬁi Bookmark Sections

* Objective
> Itis possible to Bookmark Sections and areas of TERMINALFOUR Site Manager to enable
quick access in the future.
Bookmarks are added to the Bookmarks Widget (as shown below)
Bookmark one of your sections, using the Bookmark Widget.
Test and Edit the Bookmark.
Bookmark an area of TERMINALFOUR Site Manager.

vV V VYV

| 4 TERMINALFOUR Site Manager s A  English ¥ * moderator — Logout
Content Rights & Roles Help
Show site structure
£ Site Structure & & O Q Qo &) (B (eee) («» =3
Path : Home
Sample Data (v 2 1 1 0 0
o Bookmarks
= % Home (= = 2 0 0
=T News [x] £? Add Section 3 2 0 You have no items -
— bookmarked -
®T3 Locations 5] 9 ModifySection |2 o 1
+ C1 Events = C® Delete Section 1 0 0
@ 3 Gallery (g | = Move Section 1 0 o Last Modified !’Eﬂ
D Mi B h
w’% Resources (= - Tirror Branc 2 0] 0 Content
___ | && Duplicate Branch
= % Blog (= - - 0 0
a It . o L+ Preview Section 5 0 0 Approval List
-
@ & Intranet E* Direct Edit
= B3 Tools = : 0 0 0
- B> Bookmark Section Scheduled and
= E3 Style Assets %) | @ Add content 1 0 0 Running Publishes
U £z widgets (2] & mModify Content 2 0 0
U Ea home page images [x] ¥ Delete Content 5 0 0 Search m
U 0n Widgets Homepage =) = 1 0 0

Mame: MNew Bookmark

s« A A | Dashboard | Moderator moderator | Logout |

- ™
“ How To

1. Select Bookmark Section from the Section Drop-Down Menu [z beside the section you wish to
bookmark.

2. Check the Bookmarks widget to see that your section has been added as a bookmark.

3. Bookmarks can be edited by selecting Edit in the Bookmarks widget.

4. Areas of TERMINALFOUR Site Manager can also be bookmarked, by clicking on Bookmark
located towards the bottom right-hand-side of the screen.
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® Objective
> Content is added to a section by using Content Types.
> Add content to one of your sections using the generic Content Type (the trainer will point out the
name).
> Preview the content to ensure it looks OK.
> Add the content or save as draft.

Add content. Enter content details.

Section: Home » Sample Data » Home » News

4 General Information Content Placement Channels Options Mirrored Sections

Content Type: Generic Content

i R proview |
- |
i Writing for the Web

Heading i Writing for the Web

Name *

e
o
t

ﬁ

1
W
]

«

Main Body * i - Format - | |-.li'| S 7aZ |

[—xx[Q@ L EDMHPS

Writing for the web is not the same as writing for print because people read differently on the web. One of the
impediments to online reading is physical: Tt is harder to read on a screen than it is to read on paper.

; Name of generic Content Type:

“ How To

1. Select Add Content from the Section Drop-Down Menu (= beside the section you wish to add
content to.
2. If only one Content Type is enabled, this will open straight away. Alternatively you need to select
which Content Type you wish to use.
a. The * next to the element indicates that the element is required.
b. The i next to the element gives you the details of the element; description and maximum
size.
3. Enter a Name for the content. This will not be displayed on the published page, but simply act as a
name within TERMINALFOUR Site Manager.
4. Use the Word file "Writing for the Web" and create a piece of content which looks as similar as
possible to the original.
a. Open the Word file given to you by the trainer and copy the text.
b. Paste the text into the main body of your content. Some formatting may be necessary.
5. Preview to ensure you are happy with the result.
6. Click Add to save the content once complete, or expand your options by clicking on the drop-down
icon K next to Add to reveal options such as Add & Approve and Save as Draft. The drop-down
menu options may vary depending on configuration.
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Site Manager [7.4 Direct Edit — Links and Anchors

i |
Did you know?

> There are two versions of Direct Edit. The new version can only be used with Internet
Explorer 8+, Opera and Firefox. The new version may not be enabled in your
TERMINALFOUR Site Manager.

® Objective
> There are numerous ways to add and modify content in TERMINALFOUR Site Manager. This

time we are going to use Direct Edit to add a new piece of content, with internal and external
links.

> Open Direct Edit and add a new piece of content on the same page you added the "Writing for
the Web" content to.

> Include a link to an external website (e.g. http://www.terminalfour.com), a link to one of your
other sections (e.g. "News") and a link to another attendee’s "Writing for the Web" content.
> Create an anchor link navigating from the bottom of the content back to the top.

* moderator (Moderator) | Logout
0 ) 3) 5 6] =

&' Add Content to Current Page ~ i Add New Page ~ # Modify ~ il Delete v Approve ¥ " Site Structure ~

Add content to the current page (section). \
Create a new page under the current page (section).

Modify the details of the current page (section) you are on.

Delete the current page (section) you are on.

Approve content that has been added to TERMINALFOUR Site Manager.
View the Site Structure (move sections).

1
2
3
4
5
b
T Disable and enable Direct Edit.

« How To

1. From the Site Structure, select Direct Edit from the Section Drop-Down Menu (= beside the
section you just added content to.
2. A Direct Edit screen opens with a red dotted line surrounding any content for which you have
editing rights. A Direct Edit toolbar is displayed at the top of the screen; you can use the orange
toggle button to show/hide the Direct Edit menu.
Click Add Content to Current Page.
Select a Content Type.
Enter a Name for your content.
External Link: e.g. http://www.terminalfour.com.
a. Type the text you wish to use as your link text; e.g. TERMINALFOUR.
b. Highlight the text; then select Insert/Edit Link ==/ from the WYSIWYG.
c. The Insert/Edit Link Window opens; complete the details as required.
i. Link URL: enter the URL of the site you wish to link to.
ii. Anchors: anchor links will appear in the drop-down list once you have created them.
ii. Target: select how the link should open, e.g. within the same window or in a new

ook w

window.

iv. Title: enter information about where the link will send the user; this will aid user
accessibility.

v. Class: you may have styles set for different type of links; you can select the different
styles here.

Continues >>
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“ How To- continued
7. Section Link: e.g. to one of your other sections.
a. Type and highlight the text you wish to use as the link text or simply place your mouse
where you want the link inserted. Select Insert Section Link & from the WYSIWYG.
b. A window will pop up displaying the Site Structure; navigate to the section you wish to link
to and click on it.
8. Content Link: e.g. to another attendee’s "Writing for the Web" content.
a. Type and highlight the text you wish to use as the link text or simply place your mouse where
you want the link inserted. Select Insert Content Link [ from the WYSIWYG.
b. A window will pop up displaying the Site Structure; click on the section that contains the
content you wish to link to; a list of content will be displayed.
9. Anchor Link:
a. Place your mouse where you want to set your anchor.
b. Select Insert/edit anchor & from the WYSIWYG.
c. Give your anchor a name: e.g. "top" and click Insert; an anchor icon & will be placed
indicating that an anchor has been set.
d. Type and highlight the text you wish to use as the anchor link text.
e. Select Insert/Edit Link =2 from the WYSIWYG; the Insert/Edit Link Window opens.
f.  Click on the Anchors drop-down menu and select the anchor you have created.
g. Click Insert.
10. Click Add or Save as Draft to save the content once complete. This will bring you directly to the
preview of the content, where you can test your links.

Logout
4 TERMINALFOUR ogou

Site Manager

Tl"kb\lﬂ.g Sf+¢ Contact Us  Site Map

About Us Training Overview News Writing for the Web

You are here: Home = Writing for the Web
Modify = Delete | History | ¥ Approve

Wiiting forthe Web ™"~~~ """ """ TTTTTTTTTTTT 1 [Writing for the Web

Writing for the web is not the same as writing for print because people read differently
an the web. One of the impediments to online reading is physical: It is harder to read
on a screen than it is to read on paper.

Writing for the web is not the same as writing for print because people read
differently on the web. One of the impediments to online reading is physical: Itis
harder to read on a screen than it is to read on paper.

Even the best computer monitors are hopelessly fuzzy when compared to the
crisp images on a glossy magazine page, and the extra effort this requires from
human eyes and brains slows readers down. The longer the document is, the
bigger the problem.

—ven the best computer monitors are hopelessly fuzzy when compared to the crisp
mages on a glossy magazine page. and the extra effort this requires from human eyes
and brains slows readers down.

Web Content is:
Web Contentis:

Viewed on a monitor, not in print

Low resolution (hard to read)
added text here

Scanned, not read

*
+ Viewed on a monitor, not in print
*

Low resolution (hard to read)

\
o Section/Content Links

> Section Link: a link to a section within TERMINALFOUR Site Manager. It links to the ID of
the section, which means that if the section is moved the link will stay active.

> Content Link: a link to a content item within a section. It works by linking directly to a specific
piece of content on a page which may have multiple content items on it. As a result, the link
will jump to the exact place on the page where the content starts.

TERMINALFOUR Site Manager | Train the Trainer
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® Objective

> There are numerous ways to add and modify content in TERMINALFOUR Site Manager. This
time we are going to use Direct Edit to add a new piece of content, with internal and external
links.

> Open Direct Edit and add a new piece of content on the same page you added the "Writing for
the Web" content to.

> Include a link to an external website (e.g. http://www.terminalfour.com), a link to one of your
other sections (e.g. "News") and a link to another attendee’s "Writing for the Web" content.

> Create an anchor link navigating from the bottom of the content back to the top.

* termfour (Administrator) | Logout
4 TERMINALFOUR ( "
Site Manager

K" Add Content to Current Page ~ = Add New Page ~ # Modify ~ il Delete v Approve ¥ % Site Structure ~

TERMINALFOUR Sample Site Espafiol 220 Reaster Steliap | | s-orch |

¥= Print  A-Z Site Map

News Locations Events Gallery Resources Blog Intranet

\

N
S
-~

=

Events Gallery Help Blog Intranet

You are here: Home » Fvents » Writinn Guidelines

Welcome to the Sample Site... (7 Modify = Delete | History ¥ Approve
Writing for the Web Q
Welcome to the TERMINALFOUR Sample Site, here you will find examples of some of the
hi that be achieved ily using TERMINALFOUR Site M.
sl alant it g e v JNriting for the web is notthe same as writing for print because people read differently on

‘he web. One of the impediments to online reading is physical: It is harder to read on a
screen than it is to read on paper.

=ven the best computer monitors are hopelessly fuzzy when compared to the crisp images
on a glossy magazine page, and the extra effort this requires from human eyes and brains
slows readers down. The longer the document is, the bigger the problem.

Web Content is:
Scanned, not read

Viewed on a monitor, not in print
Low resolution (hard to read)

“ How To

1. From the Site Structure screen, select Direct Edit from the Section Drop-Down Menu [=J
beside the section you just added content to.

2. A Direct Edit screen opens with a red dotted line surrounding any content for which you have
editing rights. A Direct Edit toolbar is displayed at the top of the webpage; you can use the orange
tab to show/hide the Direct Edit toolbar.

3. Click Add Content to Current Page from the Direct Edit toolbar at the top of the webpage.
4. Select a Content Type.

5. Enter a Name for your content.

Continues >>
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How To - continued

6. External Link: e.g. http://www.terminalfour.com.
a. Type the text you wish to use as your link text; e.g. TERMINALFOUR.
b. Highlight the text; then select Insert/Edit Link |==| from the WYSIWYG.
c. The Insert/Edit Link Window opens; complete the details as required.
i. Link URL: enter the URL of the site you wish to link to.
ii. Anchors: anchor links will appear in the drop-down list once you have created them.
ii. Target: select how the link should open, e.g. within the same window or in a new

window.

iv. Title: enter information about where the link will send the user; this will aid user
accessibility.

v. Class: you may have styles set for different type of links; you can select the different
styles here.

7. Section Link: e.g. to one of your other sections.
a. Type and highlight the text you wish to use as the link text or simply place your mouse
where you want the link inserted. Select Insert Section Link ' from the WYSIWYG.
b. A window will pop up displaying the Site Structure; navigate to the section you wish to link
to and click on it.
8. Content Link: e.g. to another attendee’s "Writing for the Web" content.
a. Type and highlight the text you wish to use as the link text or simply place your mouse where
you want the link inserted. Select Insert Content Link [ from the WYSIWYG.
b. A window will pop up displaying the Site Structure; click on the section that contains the
content you wish to link to; a list of content will be displayed.
9. Anchor Link:
a. Place your mouse where you want to set your anchor.
b. Select Insert/edit anchor & from the WYSIWYG.
c. Give your anchor a name: e.g. "top" and click Insert; an anchor icon & will be placed
indicating that an anchor has been set.
d. Type and highlight the text you wish to use as the anchor link text.
e. Select Insert/Edit Link =2 from the WYSIWYG; the Insert/Edit Link Window opens.
f.  Click on the Anchors drop-down menu and select the anchor you have created.
g. Click Insert.
10. Click Add or Save as Draft to save the content once complete; this will bring you directly to the
preview of the content, where you can test your links.

\
o Section/Content Links

> Section Link: a link to a section within TERMINALFOUR Site Manager. It links to the ID of
the section, this means if the section is moved the link will stay active.

> Content Link: a link to a content item within a section. It works by linking directly to a specific
piece of content on a page that may have multiply content items on it.

TERMINALFOUR Site Manager | Train the Trainer
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Create Tables in Content

‘ Objective

> Tables are sometimes used to arrange information within your content to make it easier to read.
> Create a piece of content in one of your empty sections.
> Create a table similar to the one below.

Name * i

Title

Main

)

B

Table

i Dema Table

TERMINALFOUR Sample Site

About Us Departments

You are here: Home » Depariments

Demo table

Demographics of Internet Users

Below is the percentage of each group who use the internet, according to a recent
survey.

Bod . Use the Ineternet
ody 4 Jd|®B 1 u| - Format -
P em i . a Adults 75%
R |E S| EE« |9 | | — | *x x|
IJJ\ﬂ“jﬁ?lgmmq“f\Hﬁ Women Td%
o o Men T6%
Demographics of Internet Users
Below is the percentage of each group who use the internet, according to the recent survey
d Use the Internet o
Adults 75%
Women 74%
Men 76%
o o o
_ = = = (= [E fogs
| B r U | = = = = Styles * | Paragraph - | | LIEI W Fas
&7 - =
I i < |

| =% x[Q83 &= F hHFES

o Did you know?

>

>

Once the table is inserted and selected, additional table options are enabled in the toolbar.
Hover the mouse over each icon to display the description.

Provide a summary of a table's content and structure to ensure people using non-visual user
agents may better understand it.

~

How To

From the Site Structure screen, select Add Content from the Section Drop-Down Menu (=]
beside the section you wish to add content to.

If only one Content Type is enabled, this will open straight away. Alternatively you need to select
which Content Type you wish to use.

Enter a Name for the content. This will not be displayed on the published page, but simply act as a
name within TERMINALFOUR Site Manager.

~N

TERMINALFOUR Site Manager | Train the Trainer



TERMINALFOUR
Site Manager |7.4

General Advanced

- General properties

Columns

Cellpadding

Alignment

Width

Class

Table caption

Make first row a header

Make first column 2 header

E - ]
I:l Cellspacing I:l
corter o]

[ ] Height [ ]
[-- Mot set -- [=]

(]

(]

4,

“ How To - continued

~

In the Main bodly, click Insert a table 4 from the WYSIWYG; the Insert/Modify table window pops

up. Complete the details as required.

caption.
k. Make first row a header: }
I.  Make first column a header:

Click the Advanced tab.

Class: if more than one class of table is made available, select one from here.
Table Caption: if you check this, space above the table is inserted, allowing you to add a

a. Columns: enter the number of columns required for the table.
b. Rows: enter the number of rows required for the table.

c. Cellpadding:

d. Cellspacing:

e. Alignment: As a general rule leave ]

f.  Border: these fields blank.

g. Width:

h. Height:

i.

j-

By checking these, the first row/column will
become a header. This allows data in your
table to be associated to possible headers

Enter a Summary; this should be used to describe the primary purpose of the table and give an
indication of its overall structure. Most screen readers will read the summary first to provide the

user with information to help them interpret and use the table. With more complex tables, the

summary becomes increasingly important.

Click Update to insert the table.

Once the table is created you will notice that more options are available to you in the tool bar.

Fill data into the table and merge the necessary cells for the title and description.

. Preview your content.
. Click Add or Save as Draft when complete.

TERMINALFOUR Site Manager | Train the Trainer



Site Mavsagor [7.4 History and Versions

% Objective
> TERMINALFOUR Site Manager allows you to see all changes made to content, compare
different versions and set previous versions of the content live.
> To see how this works, modify a piece of content; then compare the two versions of the content.
This can be done from the normal interface, not from Direct Edit.
> Set the original version of the content live again.

o Did you know?

> History can also be accessed from the Approve Content screen

% General Information ~Content = Placement ~Channels = Options | History | Linked Content

‘Version History for this piece of content.

Name Version Owner Last Modified Last Modified By  Previous Compare
writing for the web 0.2 No Owner set Mon, 23 Apr 2012 16:05:50 IST Training 0.1 View this Version O
Writing for the Web 0.1 No Owner set Mon, 23 Apr 2012 16:04:42 IST Training 0.0 View this Version Set Active [J

Compare

Compare Legend: Changed Added Removed

Up Version: 0.1 Swap Version: 0.2
Writing for the web is not the same as writing for print Writing for the web is not the same as writing for print

1 because people read differently on the web. One of the because people read differently on the web. One of the
impediments to online reading is physical: It is harder to impediments to online reading is physical: It is harder to
read on a screen than it is to read on paper. read on a screen than it is to read on paper.
Even the best computer monitors are hopelessly fuzzy Ewen the best computer monitors are hopelessly fuzzy
when compared to the crisp images on a glossy magazine when compared to the crisp images on a glossy magazine

2 page, and the extra effort this requires from human eyes page, and the extra effort this requires from human eyes
and brains slows readers down. The longer the document and brains slows readers down. The longer the document
is, the bigger the problem. is, the bigger the problem.

3 Web Content is: Web Content is:

4 *Scanned, not read

5 *Viewed on a monitor, not in print *Viewed on a monitor, not in print

6 *Low resolution (hard to read) *Low resolution (hard to read)

7 “added text here

Main body ~ [&) HTmL % Close

“ How To
1. Modify a piece of content select Modify Content from the Section Drop-Down Menu = beside the
section containing the content.
Click on the content’s name to open it.
Make changes to the content and click Update.
Select History from the Content Drop-Down Menu (=] beside the content.
Check Compare for two versions you wish to compare, then click either Content Comparison or
Visual Comparison.

a. Content Comparison: a side-by-side comparison of your content is displayed (see
image above). This can be displayed in Text or HTML view. Deleted content is
highlighted in red, added content is highlighted in green, and changed content is
highlighted in amber.

b. Visual Comparison: a preview of your content is displayed. Deleted content is
highlighted in red and added content is highlighted in green.

6. Close the window and click Set Active beside the original version (assuming you wish to revert to
a previous version of the content).

arwN
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Content Options TERMINALFOUR

Site Manager |7.4

) Objective

>

>

>

Once content is approved, it will automatically be published the next time a publish is run,
unless you specify a publish date.

Specify the Publish Date, Expiry Date, Content Owner and Archive Section for one of your
pieces of content.

You can use the normal view or Direct Edit.

% General Information Content Placement Channels Options | Linked Content

Content Embargo and Expiry Information

Publ

Expil

Revi

S EEEK
Content Owner
L el 7| e[ o] wof 1]

Lopione v vreview Y

ish Date (yyyy/mm/dd hh:mm)

" °
ry Date

ew Date Su Mo Tu We Th Fr

(yyyy/mm/dd hh:mm)
(yyyy/mm/dd hhzmm)
Select

No Owner set™
‘a Select Owner

*Content Ovner is inherited from branch if it is not set

opaone v ) rreview JEEY

EEERED
E  EEED
EEEER

[z]z]s].] #

Search For Users

Time 10:30

| [oeoren
Hour D Search: ® Both O Users O Groups
Minute D Togale advanced search

= (o £

\
How To

From the Site Structure screen, select Modify Content from the Section Drop-Down Menu =
beside a section containing content.
Click on the content’s name to open it.
Select the Options tab.
Fill in the relevant fields by clicking the box to open the calendar; simply click on the date you wish
to use and adjust the time by dragging the hours and minutes, then click Done. If you do not set
the time, it will default to the current time.
Click Update to save the changes to the content.

>

>
>

o Content options \

Publish Date: schedules a publish date, i.e. the date the content will go live on the site. The
content has to be approved before it can be published.

Expiry Date: content will expire and be removed from the site.

Review Date: TERMINALFOUR Site Manager will email the Content Owner. If no owner is set,
the person who last modified the content will be notified instead.

Archive Section: allows you to specify a section for the content to go to once it has expired. If
you are publishing lots of content, it may be a good idea to create an Archive Section to store
expired content in. This way the content can be used and published again at a later date. Click
Select to select a section; the section id is inserted as a reference.

Content Owner: sets an owner to the Content Item. If this is not set and the Section Owner is
set, this will be used.
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TERMINALFOUR Media Library — Training Environment
ite Manager [7.4

) Objective

> Itis recommended that you set up a training environment within the Media Library instead of
using the live site for training. This can be done within the existing Media Library to make it as
realistic as possible.

> Itis possible to assign read and write access to different users/groups, so not all users
necessarily need to have permission to upload files into the Media Library.

Media Library
E Media Library Browse
« ) » Options EH Add Media Search for an item Enter ID F\Iter: All Types - =) (i

Categorised
o E Example Site
U OO Content Images
U 3 Style Assets
= 1 Sample Data

o Media Library Overview

> The Media Library can be accessed either as a separate item (go to Content and select Media
Library) or directly from a piece of Content.
> By default, only Administrators have write access, and all user types have read access.
> The Options allow you to add new Categories (folders).
> If you right-click on a Category, the Category/Media menu displays:
o For a Category, you can Add Sub-Category, Modify Category, Delete, Rename and
Move.
o For Media, you can Add New and Show Existing.
If you modify a Category, you can determine the Write Access, Read Access, Workflow, Media
Categories (manual and automatic ordering), Auto Publish and Access Control.
The Add Media button allows you to add new media items to the category you have selected.
You can Search for an item by entering keywords or an ID.
You can Filter by selecting a specific type of file from the list.
You can switch between Detailed Mode and Preview Mode.

“ How To \

The following steps will need to be completed by an Administrator user.

To add a Category, go to Content and select Media Library.

The Media Library opens; hover your mouse over Options and click Add Category.
Give the new category a name, e.g. "Training".

The new category will be added to the Media Library.

Right-click on the Training category and click Modify Category.

Select the Write Access Tab.

Use the Search For Users to find the relevant user(s) or group(s) you wish to give write access to
the Training category.

9. Click the plus [+] beside the user(s)/group(s).

10. Click Update to save the details.

11. Members can be added and removed at any point.

\Y%

V V VYV

© N g~
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Media Library

TERMINALFOUR
Site Manager |7.4

‘ Objective

The Media Library is used to store files of all sorts to use in content. You may not have access

>

>
>

to uploading new files — this depends on your user credentials.
Open the Media Library and locate the training category.

Add a category with your own name; then upload the image you have been given by the trainer.

>

o Did you know?

The Media Library can be accessed directly from the WYSIWIG as well; this means you can

add media while you are adding the content.

Media Library

£ Media Library Browse

« | » | o options
o Add Category

oon
ooo

elete Category

Categorised

=

-]

5}

=

£3 End User Training
3 Ireland

3 Marketplace

= gample Data

= 53 Content

U B3 Photos

= C3 Style Assets Enter & name for the new Category

U 53 Training I || |

3 United Kingdom
53 United States

| ok | [ cencal |

Bl Add Media Search for an itsm Search \ Enter 1D Jump | Filter: | All Types -

NoorwDdE

“ How To
To add a Category, go to Content and select Media Library.
The Media Library opens.

Expand the tree structure to find the "Training" category and click on it.

Click Options.

Click Add Category.

A Category box pops up; enter your new category name and click OK.
Click on your new category.

Continues >>
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How To - continued \

8. To add media to your category, click Add Media (the use of Name, Description and Keywords is
dependent on your Media Layouts):
a. Name: enter a name for your Image. By default, this is not output on the site, but is used
only as a name in the Media Library to allow easy identification.
b. Description: by default, this is used as the alt tag and should hence always be filled in for
images.
c. Keywords: enter relevant keywords for the image. These are used for search purposes in
the Media Library.
d. Type: this will be automatically detected where possible. If an incorrect type is selected, you
need to add the file and then modify it again in order to change the type.
e. Syntax Type: for non-binary files you can select what syntax highlighting to use (if any).This
does not apply to images, PDFs, etc.
Media: click Browse to select the relevant image.
g. Hide Syntax Highlighting: check this option if a Syntax Type is selected and you wish to hide
it.
h.  Thumbnail: thumbnails are automatically generated for images and can be added for other
file types if needed.
i. Media Language Dependence:
i. Fully Independent: the media is the same in all languages and can hence not be
translated.
ii. Independent Media File: the file and thumbnail exist independent of language.
Other elements can be modified based on language.
ii. Fully Dependent: all elements depend on language and can be translated.
j.  Categorisation: by default, all media items are categorised.
9. Click Add.

—h

Media Library

% General Categories

General Media Information

nas QTS

ey
m
t:3

o
ﬁw
£

Keywords i

z
]
&

Type
Syntax type None |Z|

Hide syntax highlighting @

Thumbnail [] 4

Media Language Fully Independent
Dependence i v P E

Categorisation Categorised ®

[1]If you do not upload a thumbnail, the system will attempt to create one from the uploaded Media.

B2 (conce
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Using Media Items - Image Site Manager |74

® Objective
> You are going to add the image which you just uploaded into the Media Library to an existing

content item by modifying the content "Writing for the web".
> Ensure the image is in the top left corner.

Writing for the Web

Writing for the web is notthe same as writing for
print because people read differently an the web.
One of the impediments to online reading is
physical: It is harder to read on a screen than it is
to read on paper.

This is some maore text.

Even the best computer monitars are hopelessly
furzy when compared to the crisp images on a
glossy magazine page, and the extra effort this
requires from human eyes and brains slows
readers down. The longer the document is, the
bigger the problem.

Web Contentis:

¢ Scanned, notread
« iewed on a monitor, notin print
s Lowresolution (hard to read)

(= \
\

~ % How To

1. From the Site Structure screen, select Modify Content from the Section Drop-Down Menu [
beside the section containing the content "Writing for the Web".

Click on the content’s name to open it.

Place your mouse where you wish to insert the image within the main body of the content; then
select Insert Media [ from the toolbar.

The Media Library opens.

Navigate to the category where you uploaded the image earlier.

Hover over the image thumbnail and click Select.

The image is inserted in to your content.

w N

No oM
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® Objective
> Tofit an image into a piece of content, it may be necessary to resize or crop the image.
> To ensure the image is properly resized, use the Media Library’s facility to create variants.

TRAIN Image
Variations = History Usage

@ Original Version

This is an image of an image.
Type: Image

Formatter: image/™
Filename: Image.jpg

4 General Categories Image Variations

[ Select [ Mo

Image Variations

Create new Variation
» Crop
~ Resize
Resize a large image into a
smaller size. Select 3 predefined
size or enter a custom size

Custom [=]

Width: Height:
200 200

Keep aspect ratio¥]

Variant Name:

“ How To

1. From your content, click Insert Media 2] .
2. Locate the image in the Media Library; the next step is dependent on which Mode you are using
to view the contents of the Media Library.
a. If the Media Library is in Preview Mode; hover over the image thumbnail and click
Advanced.
b. If the Media Library is in Detailed Mode; click on the media item’s name.
From the Variations Tab, click Add Variant.
Either Crop or Resize the image.
Enter a Variant Name, if desired; if left blank, the new size will be used as the name.
Click Save.
Add additional variants if needed.
Once you have added the necessary variants, click Update to save.
To use a variant in content; the next step is dependent on which Mode you are viewing the Media
Library.
a. If the Media Library is in Preview Mode; hover over the image thumbnail and click
Advanced.
b. Ifthe Media Library is in Detailed Mode; click on the media item’s name.
10. All variants will be displayed. Click the radio button to select the variant you wish to use.
11. Click Select to add the image variant to your content.
12. The variant is inserted in to your content.

©oNo kW
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Edit Media Attributes Site Manager |7.4

® Objective
> You may want to specify where on the page an image should appear and how text is placed
around this image. Set the Media Attributes which will let you specify Margin, Float, etc.

Width

Height 100

Border 1

Padding E
Margin 10px

display

Float

Constrain Proportions B

4% General Information Content | Placement Channels Options Linked Content

Content Type: Generic Content

[ [ preview
Name * i Writing for the Web
Heading i Writing for the Web
Main Body * 1 QB 7 W Styles - Format - | G G 7
| E = | =% x|oE ok DEe %
= | | | !

writing for the web is not the same as writing for print because people read differently
on the web. One of the impediments to online reading is physical: It is harder to read
on a screen than it is to read on paper.

Even the best computer monitors are hopelessly fuzzy when compared to the crisp
images on a glossy magazine page, and the extra effort this requires from human
eyes and brains slows readers down. The longer the document is, the bigger the
problem.

“ How To
1. The image (or image variant) has been inserted in your content. If your media layout for images
contains style options, you can set those from the content.
Double-click on the image to open the Media Attributes.
Specify the values you wish to set. In the example above, a margin of 10px has been set, and the
image has been set to float left (hence wrapping the text around the image on the right).
Click Update to return to the content screen.
Preview your content to ensure you are happy with the result.
Click Update to save the changes made to the content.

wnN
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Site Manager |7.4 Using Media Items — PDF

\x Objective

> Modify the content "Writing for the web".
> Open the Media Library and locate your category.
> Upload the PDF "Writing for the Web Guidelines" you have been given by the trainer.
> Add a link to the PDF file to your content.
Writing for the Web

Writing for the web is not the same as writing for
print because people read differently on the web.
One of the impediments to online reading is
physical: It is harder to read on a screen than it is
to read on paper.

This is some maore text.

Even the best computer monitors are hopelessly
fuzzy when compared to the crisp images on a
glossy magazine page, and the extra effort this
reguires from human eyes and brains slows
readers down. The longer the document is, the
bigger the problem.

IFnr maore information check the guidelines: Writing for the Web Guidelines

Web Contentis:

¢ Scanned, not read
* \fiewed on a monitor, natin print
« Lowresolution (hard to read)

R
- % How To

1. From the Site Structure screen, locate the section you added your "Writing for the Web" content
to earlier.

2. Paint your mouse to the Section Drop-Down Menu (= and select Modify Content.

3. Inthe Main Body of your content, place the mouse where you want to insert the link to the PDF;
then click Insert Media.

4. The Media Library opens. Locate the Category you wish to add the PDF to and click on it.

Continues >>
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How To - continued

5. Click Add Media (the use of Name, Description and Keywords is dependent on your
TERMINALFOUR Site Manager Configuration):
a. Name: enter a name for your PDF. By default, this is used as a name in the Media Library to
allow easy identification and also serves as the link text in your content.
b. Description: by default, this is not used.
c. Keywords: enter relevant keywords for the PDF. These are used for search purposes in the
Media Library.
d. Type: this will be automatically detected where possible. If an incorrect type is selected, you
need to add the file and then modify it again in order to change the type.
Syntax Type: for non-binary files you can select what syntax highlighting to use (if any).
Media: click Browse to select the relevant PDF.
Hide Syntax Highlighting: check this option if a Syntax Type is selected and you wish to hide
it.
Thumbnail: thumbnails are automatically generated for images and can be added for other
file types if needed.
Media Language Dependence:
i. Fully Independent: the media is the same in all languages and can hence not be
translated.
ii. Independent Media File: the file and thumbnail exist independent of language.
Other elements can be modified based on language.
ii. Fully Dependent: all elements depend on language and can be translated.
m. Categorisation: by default, all media items are categories.
Click Add.
The PDF is ready to be inserted in your content; the next step is dependent on which Mode you
are viewing the Media Library.
a. If the Media Library is in Preview Mode; hover over the PDF thumbnail and click Select.
b. If the Media Library is in Detailed Mode; click on the PDF’s name.
8. The PDF has been inserted in your content
9. If you do not wish to use the PDF’s Name as the link text, double-click on the PDF link text to
open the Media Attributes.
10. In the empty Name element, enter the new link text.
11. Click Update to return to the content screen.
12. Preview your content to ensure you are happy with the result.
13. Click Update to save the changes made to the content.

x e~o

No
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Site Manager |7.4 Bringing it all together

® Objective
> Use the information from the document "International Students" to create a section with content.

> Ensure you take a best practice approach. Consider layout, structure and formatting.
> The result should be similar to what you see below:

University of Florida Graduates

More than 367,000 alumni are located throughout the world.
University of Florida graduates can be found in all 50 states and more
than 135 countries, truly demonstrating that the Gator Nation is
everywhere.

Notable alumni include Robert Cade (inventor of Gatorade), actress
Faye Dunaway, actor Buddy Ebsen, comedian Darrell Hammond,
Carl Hiaasen (columnist and novelist), Bob Graham (former U.S.
senator and Florida governor), Eleanor Smeal (former president

of National Organization for Women), and Olympic medalists Dara
Torres and Ryan Lochte.

UF alumni also include at least nine former Florida governors, two
Nobel Prize laureates, eight NASA astronauts, eight former U.S.
ambassadors, and dozens of professional and amateur athletes.

“An investment in knowledge pays the best interest.”

-Benjamin Franklin

2012-2013 Graduation Statistics

For the 2012-2013 academic year, UF awarded 14,226 graduate and undergraduate degrees. The table
below displays how many of each type of degree were awarded.

Degree Number Awarded Percent of Total
Bachelors 8,245 57.96
Masters 4,017 28.24
Doctor of Medicine 131 0.92
Doctor of Dental Medicine 79 0.56
Doctor of Veterinary Medicine 86 0.6
Juris Doctor 361 2.54
Doctor of Pharmacy 427 3
Doctor of Philosophy 880 6.19
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Mirror and Duplicate Site Manager [7.4

® Objective
> Branches of the Site Structure as well as individual pieces of content can be Mirrored and

Duplicated.

> Mirror a section if this feature is enabled. The options available will depend on the configuration.
Alternatively, duplicate a section.

> Mirror or Duplicate a piece of content. When content is mirrored, updates from either location
will affect the content from all locations. When content is duplicated, you create an independent
piece of content.

Existing Content

Hame Version Status
] DE Writing Guidelines oo =1 Pending
Content also appears in:
[} Writing Guidelines Linki o0 Sample Data » Home » Events Pending
] Select All ™
. \

How To
Mirror/Duplicate Content

1. Select Modify Content from the Section Drop-Down Menu [z beside the section containing the
content you wish to mirror or duplicate.

2. Select Mirror or Duplicate from the Content Drop-Down Menu [zl beside the content.

3. The site structure opens. Click on the section you wish the mirrored/duplicated content to appear
in. A small * "snow flake" appears beside the mirrored content. Hover the mouse over it to see the
various locations of the content. If content is duplicated it will appear as new content in the section
you have duplicated the content to.

% General Content Styles Metadata Access

Content currently in this section.
As this is a mirror of the section News, the following data is read-only.

Automatic Ordering
Enabled o
Method Alphabetical (A-Z)

Existing Content

Name Version Status Last Modified
Latest News 3.0 Approved 24 Apr'12 09:53:06
News Publish To One File  * 2.0 Approved 24 Apr'12 09:53:06
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® Objective
> When content is added to the site, it will have to be approved before it can be published and

hence "go live".
> The content you have created so far is all pending approval. Ensure your content is approved.

o Did you know?

> Approving content can also be done from the Direct Edit screen.

Approve Content

Pending Inactive Details

Documents Pending Approval

Name Priority Last Modified Section workflow
Writing Guidelines Links . Fri, 09 Sep 2011 09:38:59 15T Horme » ... » Writing Guidelines
DE Writing Guidelines . Thu, 18 Aug 2011 13:48:02 IST Horme » ... » Writing Guidelines

Home » ... » Training

‘u_ﬁ Approved Content

" Pending Content

© 0 0 Content Traffic Lights Column\
0 0
0

2 0 0 0 Inactive Content
2 0 0
1 1 0

i |
Did you know?

> If selective approval is enabled, you can approve content by checking the Approve box beside
the content and then clicking on Approve.

“ How To \

1. To approve content, go to Content and select Approve Content.
2. The Pending tab will contain a list of content you can approve.

a. Click the name to check the details of the content.

b. Hover your mouse over the section details to see the exact path to the content.

c. You can sort by name, priority or last modified.
3. Once content has been approved, it will disappear from the main list.
4. In the site structure, the approved content appears in the green column L) under the traffic lights.
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TERMINALFOUR
Site Manager |7.4

% Objective

> By default, content goes through an approval process in TERMINALFOUR Site Manager.
Moderators + can approve content in sections they are assigned to. To specify a process for
approving content, you can create workflows.

> Workflows can be created by Power Users and Administrator users.

> Add a workflow to one of your sections.

Workflows

USER ADDS CONTENT

—_—

APPROVE

O\

YOU REVIEW CONTENT FUBLISH

v

REJECT

% General | Content Styles Metadata

General information about the section.

Name

Qutput URI
Access Key

SEO Key phrase(s)
Output File Name
Status

Default Worlkflow

Show in navigation?
eForm Section?

Archive Section

Edit Rights Subsections Access

Cupaste X punien now R
E!

o

Training Overview ¥
Approved |Z|
— None -— |Z|

— Inherited — ‘
MNews undates
Training Example

_

How To

wnN

to earlier.

o oA

workflow process.

\

To build a workflow, contact a Power User or Administrator.
From the Site Structure screen, locate the section you added your "Writing for the Web" content

Point your mouse to the Section Drop-Down Menu (@ and select Modify Section.
Select the workflow you wish to use from the Default Workflow Drop-Down Menu.
The workflow is now set and all content added to the section will be approved via the specified
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Accessibility & SEO

% Objective

> Accessibility checking functionality in TERMINALFOUR Site Manager allows you to determine
how accessible your content is. This is important to ensure your site can be used by people

with visual impairments, etc.

> Search Engine Optimisation (SEO) checking functionality in TERMINALFOUR Site Manager
allows you to determine how easily a search engine can find your content. This information
can then be used to increase the visibility of content.

> Based on the information in the report, you can improve your content and hence obtain better

ranking in the search engines.

o Did you know?

periodically.

> Accessibility and SEO Reports can be run by Administrators; these can be scheduled to run

~N

t4 TERMINALFOUR Site Manager [(#AA &

= English v

* moderator | [N Locout

Content Rights & Roles Help

Show site structure

= Site Structure <>

Path : Home
Sample Data

o % Home

J 6 ®

w’% News

=} ’% Locations

4

#= 03 Events

&

(‘J\ @ o &) (B (eow) (w» o+
= 1 0 0
Bookmarks m
=l 2 1 2
4 2 o]
Last Modified
[l 2 0 1 Content
= 1 0 0

“ How To

1. Your trainer will run an Accessibility or SEO report. For one of your sections, click on the coloured
bar in the Accessibility or SEO column; this will open up the Detailed Section Report.
2. A Data Summary is displayed; click on Extended Data for more detailed information.

~N

-~ Data Summary

The Data Summary provides a condensed report of the scores of the various accessibility checks of page elements.

Channel:
Section Name:
Date Run:

Accessibility Score:

Sample Site

News

Wed, 30 Jan 2013 14:32:45 GMT
75.2%

DOM Style H1-H3 Img Alt Input Label Meta TABLE TITLE Validate
1.6% 100% 100% 0% 100% 100% 100% 100%
[ maoaify Content [Z] moaify section [ Direct edit [ preview [& rerun Report

TERMINALFOUR Site Manager | Train the Trainer



List of Content Types

TERMINALFOUR
Site Manager |7.4

® Objective

> Below is a list of some of the Content Types which are going to be used on your website.

Content Type Name

Description

Example: News

Example: This content type is to be used when adding
news items to a page. It is only available to approved Users
and only enabled for use on certain pages of the website. A
workflow rule applies to the approval process of all News

content.
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® Objective
> For users to be able to add content, they need to have access to Content Types from the site

structure. To use a Content Type, a user must also be a member of the group in which the
Content Type is available.

Modify Section, Show Details

Section: Home » Sample Data » Home » TERMINALFOUR Site Manager Training

= Site Structure 4 General Content Page Layouts Metadata Edit Rights Content Types | Subsections Access

Content Types that are assigned to this section.

Tools o ) .
= [ pubiish now IR
» E3 Style Asse -

®  Global
L fa widgets
®  sample Data
=3 home pag
B  Training Group
a Widgets t
= fa Reagister Content Type Enabled (branch) Enabled (section) Disabled
% Rating Re TRAIN Generic Content ® ® Yes
U 3 TERMINA

“ How To \

1. Assuming you already added the users to the relevant groups previously, from the Site
Structure, click Modify Section beside the section you wish to assign the Content Type to, i.e.
Training.

2. Select the Content Types tab.

3. Select the radio button to enable the Content Type either at branch or section level. If you select
"branch", the Content Type can be used for this section and its sub-sections. If you select
"section”, the Content Type can only be used for this section.

4. Click Update.
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. Objective

> You can decide which Page Layout you want to use to display the training content. You may
want to opt for an “inner” page layout to make as much room for content as possible. The
example below has the content area highlighted.

TERMINALFOUR Sample Site =eot [ | oo |

About Us Training Overview News Writing for the Web

Training Overview You are here: Home » Viriting for the Web
Top News
Training Files " -
” - thngfortheWeb TERMINAL FOUR Still Hiring
ideo Demonstrations 21 May

Writing for the web is not the same as writing for print because people _:!EEHI\:":?L';?E:EW,:::r.. at
3 ) } ) ) pany
read differently on the web. One of the impediments to online reading is
ICT Excellence Awards

physical: It is harder to read on a screen than it is to read on paper. 17 May

Even the best computer monitors are hopelessly fuzzy when compared
to the crisp images on a glossy magazine page, and the extra effort this
requires from human eyes and brains slows readers down. The longer the documentis,
the bigger the problem.

T ratning Stte

About Us Training Overview News Writing for the Web

Training Overview You are here: Home » Writing for the Web
Top News
Training Files R -
writing for the Web TERMINALFOUR Still Hiring
Video Demonstrations 21 May
\Writing for the web is notthe same as writing for print because people TERMINALFOUR wins
read differently on the web. One of the impediments to online reading is Company of the Year” at
physical: It is harder to read on a screen than it is to read on paper. ICT Excellence Awards
17 May

Even the best computer monitors are hopelessly fuzzy when compared
to the crisp images on a glossy magazine page, and the extra effort this
requires from human eyes and brains slows readers down. The longer
the document is, the bigger the problem.

“ How To

From the Site Structure, click Modify Section beside the training section.

Select the Page Layout tab and select the relevant Page Layout for your site.

Click Update.

Preview to ensure the new page layout has been applied and works as expected. This will
require that you have a piece of content to preview first.

Ao

TERMINALFOUR Site Manager | Train the Trainer



She Manager [7 4 Deleting Content after Training

® Objective
> Once training has been completed, you may wish to delete the attendees’ work in preparation

for the next training session.
> Delete sections and content which are no longer required.

= Site Structure < & o\ (7] (%)
Root = . » 0 0 0
& 1 Sample Data (= . . 1 0 0
= 03 Example Site (= 1 1 0 0 0
= £3 Training [¢] E® Add Section 0 0 0

=¥ Modify Section

C? pelete Section

Are you sure you wantto delete this section? = Move Section

1 Mirror Branch

Ok ] ’ Cancel

i A
Did you know?

> When you delete a piece of content in TERMINALFOUR Site Manager, you do not remove it
from the system immediately. Instead, an Administrator will approve the deletion before it
disappears from view. Once this is done, the content and its history will be gone from the
database.

How To \

1. Decide which of the training sections you wish to delete.
Select Delete Content from the Section Drop-Down Menu (=) beside the section you wish to
delete. This will delete the current section and all its sub-sections.
Click OK.
Repeat the above steps until you have deleted all the unwanted training sections.
The following steps will need to be completed by an Administrator user.
To Purge a Section or Content, go to Content and select Recycle Content.
The Inactive tab displays all content which has an Inactive status.
a. Check the content you wish to purge, or check Select All.
b. Click Purge to remove content.
c. A warning is displayed that you are about to delete content, click Confirm to completely
purge the content.

N

No or®

Continues >>
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How To - continued

8. The Section tab displays a list of all sections which have an Inactive status.

Check the sections you wish to purge, or check Select All.

Click Purge to remove the section(s).

A warning is displayed that you are about to delete the section(s), click Confirm to
completely purge the content.

If a purged section contained content, this content will now be moved to the Orphans tab.

a
b.
C.

N

Continues >>

Content for Recycling

Inactive

Sections Orphans

Orphaned Content

Name

Last Modified

Writing for the Web Fri, Jun 08 2012 03:07:15 PM [

Select All [

How To - continued \

9. The Orphans tab contains a list of all content which previously resided in a section which has been
purged.

a. If you do not wish to delete the content:
i.

i
i,
iv.

b. If you do wish to delete the content:
i.
i.

i,

Click on the content’s name.

The Site Structure will be displayed.

Select a new location for the content; click on a Section.

The content will be moved to your chosen section; the content status will be
Pending.

Check the content you wish to purge, or check Select All.

Click Purge to remove the content).

A warning is displayed that you are about to delete the content, click Confirm to
completely purge the content.
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SitoManager |74 Training Material and Documentation

® Objective

> TERMINALFOUR Extranet is an online resource which will provide you with documentation,
training material and extra resources which will aid you in using TERMINALFOUR Site
Manager.

HOME SITE MAF WEBSITE k] n
-G 7 o
o - %
. elearning (ontributor Moderator Training Materials Videos

You have been given access to this extranet by an Administrator of TERMINALFOUR Site Manager within your organisation.

TERMINALFOUR Site Manager is a Content Management System or CMS. It is a web application that can be accessed via a URL and valid user account and allows
you to update your website effectively in a user friendly way.

For further information on the use of TERMINALFOUR Site Manager in your organisation please contact your CMS/TERMINALFOUR Site Manager Administrator or
Web Team for information.

Use this table to find documentation on Site Manager or akernatively use the search and menu functions.

CONTRIBUTOR MODERATOR

Add Content Yes Yes
Modify Content Yes Yes
Delete Content Yes Yes
Manage Site Structure Yes

| How To \

1. When in TERMINALFOUR Site Manager, go to Help and select Extranet.
2. The first time you access the Extranet, you will need to accept the terms and conditions.
3. The menu is broken up into sections:

a. Documentation: contains end user documentation. The structure follows the
TERMINALFOUR Site Manager navigation. Version and minimum user level is highlighted
for all documentation. The documentation is spilt into Contributor and Moderator to allow
you to quickly find your information relevant to you.

b. Training Material: contains training material for Contributors and Moderators.

eLearning: contains eLearning packages for Contributors and Moderators.
d. Video Demonstrations: contain video demonstrations of exercises covered today.

0
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) Objective

> In addition to the various sets of training material available on the Extranet, we have created an
eLearning package which is designed to aid you in the training of your end users.

> The eLearning package has been designed to ensure that new and existing users can easily
access information regarding the use of TERMINALFOUR Site Manager as a Contributor or
Moderator.

Contibutor eleamang Kite [ Costent Tty O Ba-srdet Bectinss  ATTACHMENTS

TERMINALFDDI

Datlina Saarch

4 Naigaing Tz courie= Oulling Wany

& Wavigaing Fis

& Mavigaing Fis CourEa - Seandhing Contr |'|.1. or I rain |'|\.1

: N
How To
When in TERMINALFOUR Site Manager, go to Help and select T4 Extranet.
The first time you access the T4 Extranet, you will need to accept the terms and conditions.
Go to Training to find training material.
Select eLearning and choose which user level you wish to view, Contributor or Moderator.
The eLearning package will commence.

aprwhE
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